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What’s New 
 
Version 2.0 is compatible with the Site Search ONE Premium plug-in version 1.1.0+1090 or later which adds a 
PDF viewer and Media Library searching.  
 
Site Search ONE-now uses templates to control the appearance or behaviour of the Search Engine Results Page 
(SERP), Hit viewer, PDF Viewer and Search Bar Widget, this makes it possible for you to add custom scripts and 
stylesheets. 

Beta Notes 
 
Production versions will be released on the WordPress.Org Plugin Directory to enable easy automatic updates. 
Beta versions are available for those that wish to test new features ahead of official production release. 

Being a beta tester will give you the chance to contribute suggestions for improvement and to make sure ahead 
of production release that the plugin is compatible with your site configuration, theme, and other plugins that 
you use. 

 

IMPORTANT 
No automatic updating is available for beta versions of the plugin; when a new beta version is released, 
deactivate the currently installed version, then delete it from your website, before uploading and activating the 
latest build. We will advise you by email when updates to the plugin or documentation or service occur. 

We recommend that you test it on a local server or preferably on a staging site with identical content and 
plugins to your live site if it exists, before installing it on a live site.  

When merging the staging site to a live site, you do not need to re-enter your activation code, it will 
automatically create new independent indexes and start indexing your live site.  
 
Large sites with tens of thousands of posts with many Categories, Tags or Custom Taxonomies and hundreds of 
fields with dozens of values each will take many hours to create and populate the filters, facets, and indexes; we 
therefor advise putting up a 'maintenance mode' page using a plugin such as SeedProd. Note: If you are using 
the Force Login plugin you will need to deactivate it to allow the SeedProd plugin to display the maintenance 
mode page. 

 
During beta the design may change, we try to ensure backward compatibility is maintained where possible, but 
this cannot be guaranteed. 
 

FEATURE REQUESTS & BUG REPORTING 
Send all bug reports, and requests for new features or changes to support@dtsearch.co.uk with as much detail 
as possible.  

We will add all requests for features to a wish list; if your application cannot be satisfied by the current release, 
please let us know what features are needed urgently and we will try to prioritize your request. 
 

Thank you for your co-operation! 

https://en-gb.wordpress.org/plugins/
https://www.seedprod.com/wordpress-stuck-in-maintenance-mode/
mailto:support@dtsearch.co.uk
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Installation 
 

Site Search ONE WordPress Plugin is open-source and free of charge and will be available from the WordPress 
Org Plugin Directory. It requires a subscription to access a fully managed dtSearch Engine REST API running in 
the cloud that provides Search as a Service. 

A 30-day free trial period is available from https://dtsearch.co.uk/site-search-one/ The try-buy button will take 
you to the Verifone/2Checkout.com website where you can sign up, and get an activation code that will look 
something like this: 123a4b56-78c0-9d0e-1234-56f7g89h012j 

• In the WordPress Administration screen select Plugins > Add New  
• Press the Upload Plugin button 
• Press Choose File, browse to where you saved the site-search-one.zip file  
• Press Install Now  
• Press Activate. 

 

From the Site Search ONE menu – enter the activation code, this will create your account in a few seconds. 
 

 

You should now find Site Search ONE in the Dashboard like this: 

 

 

Updating 
We recommend you choose automatic Plugin updating, but if you are running the beta version the steps for 
updating are the same as above, except you need to remove the old version first: 

• Delete the old version of the plugin by going to Plugins > Installed Plugins  
• Click Deactivate 
• Click Delete. 

You will not lose your plugin’s settings by deleting the old version; the settings are stored in the WordPress 
database, which will not change when you delete things from the filesystem. 

 
 

  

https://dtsearch.co.uk/site-search-one/T
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Staging and local sites 

 
(New in version 1.3.) 
When you create a live site from a staging site, new independent indexes will automatically be generated.  

 
In WordPress Admin page, under  
Site Search One| All Search Pages you will 
find a list of Other Sites that you have created 
using the same API key. 
 

 
On the live site your staging site and any local sites created with the same API Key will be listed as Other 
Sites.  
 
If you delete your local sites or staging sites, and no longer need to test their indexes please Delete the 
indexes to keep storage costs down, so that we can continue to offer you low monthly service charges.  
We reserve the right to delete excessive data, but this will not be done without prior notice. 
 
Indexes for staging sites and live sites created from staging sites are completely independent. If you add new 
posts or pages on your live site, the live indexes will get updated automatically when new posts or pages are 
published; the indexes on your staging site will remain the same.  
 

BlogVault 
 
Site Search ONE supports staging URLs such as staging.example.com as well as backup/staging sites 
such as BlogVault with URLs such as example474.e.wpstage.net. Since BlogVault staging sites only 
last 90-days and have a different URL each time a new one is created, you should Delete old indexes in the 
Other Sites list for staging sites that no longer exist. 
 

Local test sites 
 
In the case of two sites where WordPress detects identical site URL, if the 2nd site is a copy of the 1st, the 2nd 
site will end up sharing the same index as the 1st, rather than creating a new one. This may cause confusion 
while testing. If the 2nd site is a completely new install and not a copy of the 1st, the two sites will not 
interfere with each other maintaining their own indexes 

Backups 
 
You should always keep regular backups of your live site, preferably in a location independent of your 
hosting company, so that in the event of attacks, failure of your hosting company, database corruption, etc. 
you can restore your site. For large sites choose backup software that can carry out incremental backups on a 
regular schedule such as BlogVault or UpdraftPlus.
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Creating content 

Before creating search pages, you need to create WordPress Posts or Pages in WordPress Categories that you 
want searched; you may also need to create custom fields, custom post types or custom taxonomies to 
achieve Filters or Facets search features. 
 

• To have search Filters you will need to add Custom Fields or Advanced Custom Fields (text, date, 
select) *. Filters are especially useful for date range searches or searching within Page or Post Titles 
* Note: ACF True/False fields with Custom UI Text are treated as Facets. 

• To have Faceted search you will need to add Categories, Tags or Custom Taxonomies to your Posts 
(Including Custom Posts) or Pages. Facets enable your site visitors to rapidly drill-down to the 
information they need from your site, often without including a search term. 
 

When creating content your choice of Posts or Pages may also be influenced by what your theme supports 
and what permalink (URL) structure you need for SEO purposes.  
 
Not sure whether to use Posts or Pages, or need to change from one to the other?  
This article may help (Always test plugins on a local site or staging site first): 
How to Change a Post to a Page in WordPress (and Why You’d Want To) | Elegant Themes Blog 

Excluding Posts or Pages 
 

 

 

Use this method to exclude a Post or Page from all your indexes.  

 
On each Edit screen of your Posts and Pages the Site Search ONE 
Plugin adds an option to exclude the page from appearing in a 
search, just check Do not index then Save the page.  
 
You do NOT need to manually update or rebuild the index, Site 
Search ONE will automatically re-evaluate after the page is saved 
and will remove it from the index. 

 

 

https://www.elegantthemes.com/blog/tips-tricks/how-to-change-a-post-to-a-page-in-wordpress-and-why-youd-want-to
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Creating Search Pages 
 
The steps to create and maintain Search Pages on your WordPress site are: 

• Add a New Search Page 
• Choose the Options 
• Edit the page via All Search Pages to add new content 
• Maintain the search results via All Search Pages where you can  

Rebuild - Update – Delete or Compress the indexes 
or Edit the Posts or Pages to be indexed 
or change the Options at any time. 
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Search Page features 
A search page (a.k.a. SERP – Search Engine Results Page) contains a search bar at the top of the page, with 
the search results list underneath. The search results show the page title with a snippet of context 
surrounding the highlighted search word or phrase.  
 
Clicking on the title in the results list takes your website visitor to the original page or a page with the hits 
highlighted depending on the search page options the site administrator has chosen. 
 

Sorting 
Search results are sorted by relevance by 
default with 10 items per page. Choose to 
sort alphabetically (a-z or z-a) on the 
Page or Post Title, or sort on publication 
date (oldest or newest).  
 
If Initial Search option has been selected, 
results will be sorted by Publication date, 
with newest at top.  
 
NOTE: Title must be unique, to enable 
correct alphabetic sorting and to ensure 
they are not excluded as duplicates or 
overwrite posts in the index with the 
same title. Unique titles also improve your 
website SEO. 

Optional features 
Search expansion using Stemming or 
WordNet synonyms. 

Categorized search 
The search bar may have a drop-down list 
on the left, if present we refer to this as 
Categorized search.  

Filtered search 
On the right-hand end the search bar may show a Filter symbol, this is for narrowing down a search using 
Custom Fields, such as date-range or searching for words within the Page or Post Title. 

Faceted Search 
There may be a row of checkboxes to the left of the search results (or above the results on a mobile device). 
These are called Facets and use Post Tags, Categories, Subcategories or Custom Taxonomies to offer Faceted 
Navigation for quickly ‘drilling-down’ to the information your site visitor needs, when combined with a search 
query in the search textbox it is referred to as Faceted Search  
 
All Words, Any Words, Boolean search type 
As standard you can use one type of search for all search pages. The Premium subscription allows search 
pages in any of the search types, with user selection of search type. See Premium User Guide. .  
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Search Results 
At the top of each Options page is a 
Results section with several options: 

Initial search 
With this checked, as soon as a user 
navigates to the search page it will display 
results using an xfirstword search 
query; this displays a snippet from the start 
of each page, with the first word 
highlighted. Sorting is by Published date. 
If unchecked, it will simply show the search 
bar with no results.  

With results showing straight away, users 
can quickly browse using the facets 
(faceted navigation). The demo pages on 
dtSearch UK have this selected. It is 
designed to demonstrate the usefulness of 
letting users quickly narrow down the 
search results using faceted navigation. 
(* New in version 1.6) 

Open in New Window 
If this is selected, it will open the original 

page in a new tab in your browser. This can assist users to easily navigate back to your search results page. 

Link to Original Page 
This is most often needed for search pages that link to short News pages or Products pages, where the user 
needs to get to the content quickly; if your content has long sections of text, where your site visitors need to 
get to specific information contained on that page, a better choice might be Link to hit Viewer. 

 

Link to hit viewer 
Choose this if your search page links to long Posts or Page content, each word from the user search query 
will be highlighted in a different color. There is a delay in displaying long text, particularly the first page. If it 
important that the user gets to the page quickly, for example if your site is selling products or has short posts, 
then choose the Link to original page. From version 1.2 the Hit Viewer overlays the results page. 
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Link Format 
 
(New in version 1.9) The Dashboard now has a Global Settings section.  
For the link format, the global setting will be used if the following conditions are true: 
1. The global setting is not blank 
2. The search page link format setting is either blank, or unchanged from the default link format.   
Therefor it's possible for a search page to override the global setting by using a non-default link format. 
 

Title  
By default, the link will be the page or post Title. Enter title as %%doc_title%% 
The title must be unique, add a field if necessary to achieve this. 

Field 
If you need to sort your results in a special order or need to distinguish between similar pages or posts, you 
might need to add a field value.  
To display field values in the document, use the format %%field:fieldname%% 
For example, to display the 'Brand' field use %%field:Brand%% 

Optionally, to specify text that appears before and after a field, use the format: 
%%field:fieldname:textbefore:textafter%% The text will only appear if the field is present 
within the document. For example, to display an 'ID' field in closed brackets, but only print the brackets if ID 
exists, use %%field:ID:[:]%% 

 
The Published date can be displayed in any format in the link, by passing the date format in parenthesis.  
Examples: %%field:Published(MMMM):[:]%% will display '[January]'.  
 
(New in version 1.6) You can also style the link format (See also under Advanced section) 
<h4 class="link_title">%%doc_title%%%%field:Published(MMM D, YYYY): - 
:%%</h4> will display the Published date in US format after the title, separated by a hyphen. 
 
For a full list of supported formats, refer to the link below: 
https://momentjs.com/docs/#/displaying/format/ 
 

Snippet size 
(New in version 1.6) The number of words returned in the snippet can be chosen like this: 
%%context:50%% will bring back 50 words of context either side of the hit word. 
%%context%% on its own will bring back a default 25 words. The limit is currently 200 words of context 
max. 

 

Advanced 
(New in version 1.6) The Link format option now controls everything below a search result link, allows 
multiple lines of text and supports HTML, making it possible to create highly customized search result 
appearance, images, etc. Clicking the words of context will now also open the search results page. 
 
  

https://momentjs.com/docs/#/displaying/format/
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Context class 
There is a built in CSS rule for the context class that will prevent the text being styled as a link when hovered. 
To prevent any elements from being styled as a link enclose it within a context class. The Image display 
example below shows how this is done. 
 
Example: 
<div class=example-meta-date>%%field:Published%%</div><h3> %%doc_title%% 
%%field:Name%%</h3> 
<p class="context">%%context:40%%</p> 
<p class="readmore">Read more…</p> 

The style can be controlled in the CSS Search Results box, for example: 
a .context { 
  font-size: 16px; 
} 
p.readmore { 
  font-size: 16px; 
  font-weight: 500; 
  color: rgb(40, 115, 251); 
  text-decoration-thickness: auto; 
  text-decoration-style: solid; 
  text-decoration-color: rgb(40, 115, 251); 
  line-height: 25px; 
  text-decoration-line: none; 
} 

Image display 
Using the Advanced Custom Fields plugin, create a field with Url type, create a rule so that the field is used 
within the desired Custom Post Type. The below example shows how you would add HTML to display an 
image using a Url type called productimage 

<p><h4 class="link_title">%%doc_title%%</h4></p> 
<p class="context">Barcode: %%field:barcode%% 
<br/> 
Brand: %%field:brands%% 
<br/> 
Food Type: %%field:type%% 
<br/> 
<img src="%%field:productimage%%" width="150" height="150"> 
<br/></p> 
<p class="context">%%context%%</p> 
 

See also Featured Image or WooCommerce Product Image display 
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Excerpts 
 
(New in version 1.7) The link format now allows the excerpt field to be displayed in search results. The 
example below shows how the excerpt can be shown if the search query is blank but will otherwise show 27 
words of context either side of the hit-highlighted word. (To match the WordPress 55 word excerpt default) 
  
<h3 class="link_title">%%doc_title%% | %%field:Published%%</h3> 
<p class="context"> 
   <span class="user-excerpt">%%field:_excerpt%%</span> 
   <span class="dts-excerpt"> 
  <br> 
  %%context:27%% 
  </span> 
</p> 
 
The CSS Search Results below will show the excerpt field if the search query is empty. 
 
body .user-excerpt { 
  display: none;} 
body.empty-query .user-excerpt { 
  display: unset;} 
body.empty-query .dts-excerpt { 
  display: none; 
} 
body.empty-query .user-excerpt:empty + .dts-excerpt { 
  display:unset; 
} 
body.empty-query .user-excerpt:empty { 
  display:none; 

} 

 

Featured Image or WooCommerce Product Image  
Requires Premium Plugin (Also see Premium User Guide) 
 
(New in version 1.7) The link format now allows the featured image to be displayed in search results. 
Displaying an image is done by using: %%img: featured_img%%  
  
Optionally a class name can be passed as an argument, for example to add the class thumbnail: 
%%img:_featured_img:thumbnail%% 
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Document Display 
 
Show All Field data 

 
Select to show field data at the 
bottom of the Hit Viewer.  
 
Includes FileUUID, Filename, 
SHA265 Hash & Published date 
for security and bug tracking. 
 
 

 

Show selected 
 
If you prefer not to show FileUUID, Filename, and SHA256 Hash, which are intended for security and error 
tracking, we recommend that you show selected field data whose values are likely to be used in search 
request – this will avoid users being confused if their search request includes words in fields that would be 
included in the hit total, but would not be visible to them unless the fields are shown after the document 
body. 

 

Need more? 
On our wish list is having a textbox alongside ‘Initial search’, so that if the initial search is checked and a 
search request is in the textbox, it will carry that search out instead of an xfirstword search; for example 
it might be useful on sites that want to promote the latest product or the latest news or a sale item, or just an 
example complex search query. Contact us if this is a priority for you! 
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Categorized Search 
If you need to have a drop-down list of indexes on the left-hand end of the search bar, simply add other 
indexes from the Options page. See the categorized search in the demos section. You can of course name 
the search page to suit your own site, for example Products, Departments, etc. 
 
If you also want to offer your site visitors the ability to search all the indexes at once (called federated search), 
see below. 

Federated Search 
Federated search is when the search query is applied to several sources simultaneously. From the Options 
page of each search page there is a ‘search all’ checkbox, if checked, a top-level renamable item will appear in 
the drop-down list of indexes at the left-hand end of your search bar (and the site Search ONE Search bar 
Widget if used). 
 
CAUTION: With federated search, when the user selects the top-level ‘search all’ item, the Filters (Fields) for 
all the pages will be listed in the drop-down filters list. This could result in a search query giving a ‘not found’ 
result if the user is not aware which field applies to which index. It is preferable that all the indexes share the 
same fields. 
 

Filters 

To have search Filters you will need to add WordPress Custom Fields or add Custom Fields using a plugin 
like Advanced Custom Fields (ACF) or Custom Post Type UI (CPT UI).  
 
Filters are especially useful for date range searches in date type fields or searching a text type field for words 
within a Page or Post Title.  
 
The ACF Select field type is also supported, this allows you to add a drop-down list of field values, this is 
generally suitable where there are between 5 and 15 values. From the Options page select the fields from the 
filters list. If you don’t want filters leave the items in the list unchecked. 
  



16 

Faceted Navigation 
If your posts have Tags or your search page includes Posts or Pages in multiple Categories or Sub-Categories, 
Facet checkboxes will appear to the left (or above, on small screens) of the list of search results.  
 
From version 1.6 the Facets to be displayed can be chosen in the Options panel. 
 

 
 
To illustrate the power of browsing using faceted navigation instead of finding information by using a search 
query, the demo pages at https://dtsearch.co.uk have been set to carry out an Initial Search of all the 
documents in the index (hidden search query = xfirstword); site visitors can quickly browse through all 
the posts/pages by selecting the facets of interest, they can also enter a search at any time to further narrow 
down the result set. Faceted Navigation augmented with search is referred to as Faceted Search. 
 
Faceted Navigation overcomes the problem that the user may not be familiar with the content of the site, and 
therefor has no idea what search queries might be productive. It quickly exposes the content by means of 
snippets in the result list, and the user is quickly able to navigate the content by looking at the terms in the 
Tags, Categories or Custom Taxonomies.  
 
The downside is the additional Administration time and effort required to add Tags to posts/pages, and to 
allocate posts/pages to appropriate Categories and Subcategories. 
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Any Words, All Words search types 
 
From the Options section of each search page, scroll to Search type, you can choose a search type of Any 
Words, or All Words instead of the default Boolean search.  

 

Any Words and All Word searches are better suited to eCommerce use, or where your site is intended for 
users who may not be familiar with using Boolean searches. 

All-Words search will make the search more specific as words are added, the user can then remove words if 
no results are found.  

Any Word search is very broad and is less likely to result in ‘no results’ 
 
(Prior to August 2022, this feature required a Premium subscription, it is now included in your basic 
subscription). 
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Search bar Widget 
The Search bar Widget allows you to choose the text and background color, the radius of corners, and has a 
responsive design to suit iPads and mobile phone displays as well as large screen devices. It also allows you 
to add custom CSS to further style its appearance.  
 

 

The search bar can be installed to anywhere that widgets are allowed from WordPress Dashboard in the 
Appearance > Widgets section. The appearance of this section will be different if you have installed and 
activated the Gutenberg Plugin: (If you are using the Oxygen builder you will need to install it from there). 

To add the widget to a page using the classic editor, drag the Site Search ONE – Search Bar from Available 
Widgets into a Widgets area on the right. To add the widget using the Gutenberg Plugin:  

Click + button  

 

 

After clicking the + button you will see a search box 

At any time, you can change the appearance of the Search bar in Appearance > Customize from the 
Widgets section. If you have several search pages, you can choose to hide the search bar or stemming and 
synonyms checkboxes from any search page from the Options section of any search page. 
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New in version 1.1 user choice of search type (Any words, All words, Boolean) added to search widget; these 
are set from the Options panel of the actual search page (Products and News in the example below)  

 

A search bar with Border Radius set to 20. If your theme has fixed column widths, you may need to edit CSS 
rules to change the column width to be able to show a long search bar that includes a filter button and index 
selector dropdown list 

 

Title: enter a title for the Widget Section if needed 
or leave blank.  

Search page: select the search page from the 
dropdown list. Note: Filters are setup from the 
Search Page; click the Options button and 
choose the required Filters. (Currently Text, Date 
and Select ACF fields are supported).  

Hide stemming and synonym checkboxes from 
the search widget if your theme has limited 
height, or you need an uncluttered look.  

Click on Select Color to adjust the Background 
color or Text color to match your site’s theme. 
You can enter a Hex code like #3973ac for an 
exact match if you know your theme’s colors or 
simply adjust from the color picker.  

Placeholder text: Having some placeholder text 
is known to increase the number of people that 
will search on your site and can be as simple as 
‘search’ to ‘what are you looking for? or 
something more specific to your site.  

Border Radius: enter a value from 0 to 20.  

Example with Border Radius of 5 
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Custom CSS 
 

The Search Widget can be styled further in Appearance >Widgets in the Custom CSS section.  
(New in version 1.4.0 - 18 Nov 2021) 

Example: 

 

 

 

 

 

This example illustrates how you can change the 
background color of each section of the search 
bar to match your site theme. 

It also shows how you can further change its 
appearance in dark-mode.  

 

If you want to display the stemming and 
synonyms checkboxes, and search type buttons 
on each search page but need to hide them on 
the search widget (for example there may not be 
room if the widget is in a sidebar or in mobile 
mode) you can hide the stemming and synonyms 
checkboxes by using the checkbox as shown on 
page 4, and you can hide the search type radio 
buttons by including this in Custom CSS:  

 

#search-type-container {  

Display: none;  

} 

 

See: https://www.w3schools.com/css/css_colors.asp 

https://design.google/library/material-design-dark-theme/  

https://material.io/design/color/the-color-system.html#tools-for-picking-colors  

https://www.w3schools.com/css/css_colors.asp
https://design.google/library/material-design-dark-theme/
https://material.io/design/color/the-color-system.html#tools-for-picking-colors
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User Defined Synonyms 
The built in WordNet synonyms are limited to English (including US, British and Australian variants) and has a 
large vocabulary, however if your site needs to operate in other languages, needs to cover specialist domains, 
or include product brands, you may need to define your own synonyms to ensure your site visitors find what 
they need. Many search engines offer simple single word synonym matching, but our premium solution also 
matches phrases, for example a search on MFP could find ‘multi-function printers’, or ‘all in one printer’! 

See the User Guide for Premium Add-ons. 

Pagination 
Pagination is fixed in this version, each search page displays 10 results in a list, with a maximum of 50 pages 
(500 results). The navigation in the results page and in the hit-viewer is by Previous, Next, First and Last 
buttons, among results and ‘hits’ respectively.   

On mobile devices the pagination is 
simplified to just show the current page 
number with the navigation arrows. 
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Demonstration search pages 
http://dtsearch.co.uk has several search page demonstrations, this user guide will explain the steps to create 
each of them to illustrate how to set up Site Search ONE and how to create Custom Fields, Custom Posts or 
Custom Taxonomies to achieve those results without any coding.  Choose the option closest to your own 
needs. If your needs are not achievable, please contact support@dtsearch.co.uk  

 Post Type Filters Facets Indexes Note 

News Post with a 
Category of 
News 

Date Range based 
on date of 
publication 

Based on Tags One  

Legal Post with a 
Category of 
Legal 

Based on Advanced 
Custom Fields for 
‘Date of Judgment’ 
and ‘Case Title’ 

- One 1 

Car Custom Post Based on Custom 
Fields 

Based on Custom 
Taxonomies 

One 2 

Book Pages Based on Custom 
Fields 

 One  

Products Page with a 
Category of 
Products 

 Based on Tags and 
Subcategories 

One  

Categorized All Above As Above As above Multiple  

Products & News. 
Uses the theme’s 
default search box 
- all pages except 
home page 

 

Page with a 
Category of 

Products  
and Post with 
a Category of 

News 

None Based on Tags 
and Subcategories 

One 3 

Products and 
News. Uses the 
Search bar Widget 
add-on 

Advanced Custom 
Fields Select type 

Based on Tags and 
Subcategories 

Two 4 

Food & Drink Custom Posts Advanced Custom 
Fields Select type 

Based on Custom 
Taxonomies 

One  

WooCommerce Products None WooCommerce 
Product Tags, 
Categories & 

Attributes 

One  

1 - Legal Search: Uses default Post types with a Category of Legal, uses the free Advanced Custom Fields 
(ACF) plugin for creating Custom Fields to filter on Case Title and Date of Judgment 
2 - Car Search: Uses Custom Posts with Custom Taxonomies for Faceted search on Colour, Fuel, Engine size, 
etc. Uses the PODS plugin. Uses Dashicons or custom icons for dashboard navigation. 
3 - Products & News Search: Uses Pages with a Category of Products and various Subcategories and Tags. 
Uses the free Post Tags and Categories for Pages Plugin to be able to associate Pages with Categories and 
Tags. News search index includes a demo of user defined synonyms – see About News Search page 
under the top Search menu. 
4 – Products and News: Uses the Categorized ‘Search All’ option   

http://dtsearch.co.uk/
mailto:support@dtsearch.co.ukT
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News Search 
 
Create content: 
Create content using the default Post type; this would also be suitable for a blog search. You will also have 
the Default Post Category set in Settings | Writing as News or Blog as needed, and the Permalink structure 
set in Settings to include the date for SEO purposes. It is common to have a sidebar to list Recent News or 
Blogs and possibly a drop-down list to show an archive of older items. 
 
New Search Page: 

 
 
Page Title: 
Enter the Page Title, keep this short, spaces are allowed 
 
Pages 
We only need default Posts to be indexed, so leave Include selected, but 
do not select Add Page… 

 
Posts 
Select Include: and choose the News or Blog Post Category that the Posts 
have been created with. 

 
Post Types 
Choose Selected post types: and Posts 

Press the Next button, your index will be created within a minute or so 
depending on the size and quantity of your Posts; you will be returned to 
the All Search Pages screen. 
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The All Search Pages screen shows a 
summary of the content, press the Options 
button. You can access All Search Pages 
from the WordPress Dashboard at any time 
to change the Options or Edit the content of 
any of the Search Pages. 

Filters 
The News Search Posts will not have been 
set with any Custom Fields, to prevent the 
Filter from appearing on the search bar, 
select Include: but don’t select anything 
from the list.  
 
As an alternative you can select the 
Published field to allow users to narrow 
search by date range. 
 
Indexes 
We only want News items to be searched 
from the search bar, do not select any other 
indexes.  

Index Name  

This will default to the same name as the 
Page Title and is the name that will appear in 
the drop-down list if categorized search is 
used. 

Search bar 
If you are using the Search bar widget or a 
search bar supplied with your theme, you 
may want to hide the search bar or 
stemming and synonyms checkboxes on the 
search page. 
 
Synonyms 

Enables you to create your own synonyms for use with each index. Premium feature that includes a 
subscription to User Thesaurus Plus. See the Premium Add-ons User Guide. 
 
Search type 

• Default search type. Choose All Words or Any Words instead of the default Boolean search type. You 
can try any of the search types on your site for 30-days before choosing which one you need. If you need 
more than one search type, see the Premium Add-ons User Guide. The example above shows that Boolean 
search is used for the News Search page, with no user choice. 
• User Choice (Available from version 1.1 onwards) 
If you want to allow front-end (site visitors) choice of the type of search, select 2 or 3 of the User Choice 
checkboxes. This is a Premium subscription option)  
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Book Search 
 
Create content: 
Create content using the default Page type. This method enables you to search existing pages, each time you 
Publish a new page you must add it via All Search Pages; press the Edit button on the search page. For a 
solution that adds new Pages to the index as soon as they are published and can add Faceted search based 

on Tags and Subcategories, see the Products demo. 
 
New Search Page: 

 

Page Title: 
Enter the Page Title, keep this short, spaces are allowed 
 
Pages 
Select pages from the drop-down list, hold the Ctrl key 
down and select each item needed with the mouse. You 
can also remove each page from here:

 

 

Ignore other sections 

 
Press the Next button, your index will be created within a 
minute or so depending on the size and quantity of your 
Pages; you will be returned to the All Search Pages 
screen where you can choose Options for Filters and 
display of search results. 
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Options - Book Search 

Filters 
The Book Search Pages will have been set 
with Custom Fields typically for things like 
Author, Publisher, Publication Year, Title, 
Genre, or even ISBN, so select all the fields 
that you want to appear in the Filter drop-
down list on your search bar 

Indexes 
We only want Books items to be searched 
from the search bar, do not select any 
other indexes.  

Index Name  
This will default to the same name as the 
Page Title and is the name that will appear 
in the drop-down list if categorized search 
is needed. 

Search bar 
If you are using the Search bar widget or 
a search bar supplied with your theme, you 
may want to hide the search bar or 
stemming and synonyms checkboxes on 
the search page. 
 
Synonyms 
This is a premium add-on feature. It 
enables you to create your own synonyms 
for use with each index. See the Premium 
Add-ons User Guide. 

Search type 
You can choose All Words or Any Words 
instead of the default Boolean search type. 
Try any of the search types on your site for 
30-days before choosing which one you 
need. If you need more than one search 
type, see the Premium Add-ons User 
Guide. 
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Products 
This demonstrates how you can add faceted search using Tags and Subcategories to your existing or new 
Pages. 

Create content: 
Install and activate the free Post Tags and Categories for Pages Plugin, go to Pages » Add New, you will find 
Categories and Tags available for each of your Pages. Add the Products Category and Subcategories from here 
or from any of your Pages using +Add New Category; to create Subcategories select Products from the Parent 
Category dropdown. 

Create content using the default Page type. 

 

 

 

 

 

 

From the Dashboard Pages » All Pages for all existing 
product pages, use Quick Edit to check the Products category and/or 
Subcategories to make it easy to filter on a Category in future. 

 

 
 
Add Tags based on the page content for faceted search. 

 
New Search Page: 

Select New Search Page from Site Search ONE, enter the Page title: Products 
 
Pages 
Select the By Category radio button, in the Categories list select Products. If only one top level Category is 
selected, only its subcategories will appear as Facets. 
 
Posts 
Select Include: but do not check any boxes (Note: if a different Post top level Category is also chosen, for 
example Pages with a Category of Products, and Posts with a Category of News then both top level categories 
will also appear as Facets in the frontend. Otherwise, if Posts with a category of Products is also chosen then 
Products will not appear as a Facet in the frontend. 
 
Post Types 
Choose Selected post types: but do not check any boxes. Press the Next button, you will be returned to the All 
Search Pages screen where you can choose Options. See Book search page for an example.  
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Legal Search 
 

Create content: 

Under Posts create a new Category: Legal.  

Use the Advance Custom Fields (ACF) WordPress Plugin to create Custom Fields of Date of Judgment and 
Case Title: 

Add New Field Group = Legal. 

• Add New field, Field Label = Date of Judgment Field Name = date-of-judgment 

• Choose Field Type > JQuery >Date Picker.  Required? = Yes. 

• Choose a Display Format = Custom Y-m-d (e.g., 2021-04-16) and the same for Return Format 

• Rules = Post Type is equal to Post and Post Category is equal to Legal 

• Press Publish Update  

 
Follow the steps above to create another Required field with Field Label = Case Title and 

Field Name = case-title Field Type = text with a character limit = 80 and the same Rules as above. 

 

When you edit a Post with a Category of Legal, you will now see below it two required fields: 

 
Clicking in the Date of Judgment text box allows you to pick a date from a calendar control. 

If the Posts permalink includes a date, note that it will be the date you published the Post, which may be 
acceptable if your pages are blocked from being indexed by web search engines.  
 
If you intend the posts to be found on the Public web, you might want to consider making the Published date 
the same as the Date of Judgement, or use Custom Posts to make a permalink without a date. 

With standard Posts you can use Tags in the post as Facets. 
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Legal New Search Page: 

 

Page Title:  
Enter the Page Title, keep this short, spaces are allowed 
 
Pages: 
Select Include: but do not select any pages 

Posts: 
Select Legal category 

Post Types: 
Select Posts only 
 

Ignore other sections. 

 
Press the Next button, your index will be created within a minute or 
so depending on the size and quantity of your Posts; you will be 
returned to the All Search Pages screen where you can choose 
Options for Filters and display of search results.  
 
The demonstration page uses Results link to hit viewer and Filters 
of Case Title and Date of Judgment 

 
Ignore the Indexes and Index name sections 

Synonyms and Search type 
See Book search or Premium Add-ons User Guide 

Save the settings. 
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Car Search 

Create content: 

Use a plugin like PODS to create a Custom Post type of Cars and Custom Taxonomies of Brand, Color, 
Engine, etc. 
 
New Search Page: 

Page Title:  
Enter the Page Title, keep this short, spaces are allowed 
 
Pages: 
Select Include: but do not select any pages 

Posts: 
Select Include: but do not select any posts 

Post Types: 
Select Cars only 
 

Ignore other sections. 

 
Press the Next button, your index will be created within a minute or so depending on the size and quantity of 
your Posts; you will be returned to the All Search Pages screen where you can choose Options for Filters 
and display of search results.  

 
Ignore the Indexes and Index name sections 

 

Synonyms and Search type 
See Book search or Premium Add-ons User Guide 

 
Save the settings. 
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Categorized Search 
 
Categorized search adds a drop-down list to the left-hand end of the search bar, the list contains a sorted list 
of Index Names.  

When you have completed creating search pages for the various categories of data on your website, from 
WordPress Admin area under Site Search One, select All Search Pages.  

Choose one of the pages that you want to be available in the drop-down list (in our example we chose Cars) 
and click Edit, from the Edit Search Page edit Page Title to Categorized Search. 

Click the Next button 
From the All Search Pages screen select the Categorized Search page, press Options.  
From the Options screen under Indexes select all the indexes that you want to be selectable from the 
dropdown list on the Categorized search page. The indexes will be automatically sorted alphabetically in the 
dropdown list. 

Click the Save button. 

If you have previously assigned the chosen search page to a menu, it will have been renamed to Categorized 
search. 
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Categorized ‘Search All’ option 
 
From the WordPress Dashboard Site Search One > All Search Pages scroll to the name of the search page 
you want to search, select the Options tab.  

In the Indexes section check the checkbox alongside the ‘Search all’ textbox and enter a name for the top-
level search e.g., Products and News. ‘Search all’ will apply to all the selected indexes in the list and the Index 
name for that search page.  

            
                

 

  

(Above) 
How it 
will 
appear 

on your search bar. 

 

 

 

Note: this is suitable where the indexes share common fields and facets. The Categorized demo page on 
dtSearch UK is not suitable because it includes books, laws, cars which have widely different fields and facets. 
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Products and News demo 
 
For the demo of this feature on the dtSearch UK site, a separate index called Products was created using 
Pages with a Category of Products (with no sub-categories selected). From the Options page, the News 
Search page was selected and finally the ‘search all’ checkbox was selected and renamed Products and News 
(see image above). 

The Products and News demo is used to demonstrate the use of ACF (Advanced Custom Fields) Select type 
as Filters that appear on the Search Widget, and (if not hidden) in the search bar on the Products and News 
Search Results Page. 

 
This also illustrates the problem of using the ‘search all’ option (also known as federated search), when 
Products and News is selected in the dropdown – all the fields are available as Filters, even though Published 
Date only applies to News posts, and the drop-down filters only apply to products. 

It is suitable for example in an index of Books where the Categories might be different libraries, an index of 
hotels where the categories might be countries, or star rating or region. 

 

Products & News demo 
 

This demo uses the theme’s default search box. To create a search page that takes input from your site’s 
default search box or search widget, select the checkbox in the default column as shown below. 
 

 
 

  



34 

Food & Drink demo 
 
This demo displays Post Content and Excerpts in the results, together with other fields for Barcode, Brand and 
Food Type, as well as an Advanced Custom Fields URL field type to display an image. 
 
The Facets are created using the CPT UI plugin to create a 'Food' Custom Post. 
 
After the Food Type is created, use the Advanced Custom Field plugin to create a Select type of field, this is 
also used as a Filter.  
 
 
This type of search page could also be used for a catalogue for a museum, art gallery, auction site, or for a 
manufacturers parts catalogue for items that are not necessarily for direct sale on the site. Here for example, 
we use the barcode link to go to another site where the product may be available for purchase or to find 
more details. 
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WooCommerce Search Demo 
 

See: https://dtsearch.co.uk/about-woocommerce-search/ 

 
This demo uses CSS Conditional Rules and Conditional Sorting, it also uses the Premium Plugin to display 
Product Images. 

 
All WooCommerce Product Fields are detected such as SKU, ProductColor, ProductSize, etc. and these can be 
displayed in the search results or used as Filters. 

https://dtsearch.co.uk/about-woocommerce-search/
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Date Range Filter 
 
The Site Search ONE date range filter uses the date of publication of Posts or Pages, this shows up as 
Published in the list of Filters on the Options page. 

 

 

In addition, if any Advanced Custom Field is detected as a Date type the Date Range Filter will automatically 
be used in place of a textbox on the search bar Filters window. 
(This has been tested only with the Advanced Customs Fields Plugin as of 22 April 2021) 

 

The user can type the date in or use the calendar controls. 
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Compatible Plugins 
The demonstration search pages on our website serve to illustrate the frontend capabilities of the Site Search 
ONE WordPress Plugin, to achieve the Facet and Filter capabilities, the various Posts and Pages need to have 
post-meta data added either using the built in Custom Fields or by creating Advanced Custom Fields, Custom 
Posts or Custom Taxonomies using other WordPress Plugins. 

 
The following Plugins were used for this purpose on our demonstrations, other plugins are also available 
which could serve the same purpose, but which may not have been tested for compatibility. If you experience 
any issues using similar Plugins, please contact support@dtsearch.co.uk for assistance. 

 

PODS 
The WordPress Plugin https://en-gb.wordpress.org/plugins/pods/  has been tested with Site Search ONE 
and is useful for adding Custom Post types and Custom Taxonomies. An advantage of Custom Post 
types over the default Post types is that you can make the WordPress Admin area (Dashboard) more 
user friendly to staff that add and maintain content to your site. For example, you can use different 
icons for each type of Custom Post to make it easier to locate: 

Adding icons to the WordPress Dashboard 
 
From the Edit PODS menu select the Custom Post type and under the 
Admin UI tab, add the URL or dash icon name, here for example we chose 
the dashicons-car for our Cars search demo. 

 

 

 

 

 

Another advantage is that the WordPress 
Custom Fields are by default just text 
areas. Pods allows you to create Custom 
Fields with a date type. Dates Pods are 
stored in the ANSI standard of YYYY-MM-
DD. 

  
  
 
Custom Post Type UI (CPT UI) 
This plugin by WebDevStudios is useful for creating Custom Post types and Custom Taxonomies and is 
compatible with Site Search ONE.

mailto:support@dtsearch.co.uk
https://en-gb.wordpress.org/plugins/pods/
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WordPress Custom Fields 
WordPress displays a custom fields meta box at the bottom of the Edit Posts window, you can select your 
custom field from the drop-down menu and enter its value. See Custom Fields | WordPress.org 

 
Click the Add Custom Field button to save your changes, then publish or update your post.  

By default, WordPress only loads 30 custom fields in this form so you may not be able to see the Custom 

Field you need. It is better to install a plugin to enable you to enter Custom Fields and these will also let you 

have date type and other types beyond the default plain text type, for example Advanced Custom Fields, or 

the previously mentioned PODS. 

 

Advanced Custom Fields (ACF)  
ACF was used for the Legal search in the Categorized search demo, and Products search. 

See https://en-gb.wordpress.org/plugins/advanced-custom-fields/ 
 
 

Post Tags and Categories for Pages 

The free Post Tags and Categories for Pages Plugin was used to add Categories, Subcategories and Tags 
for the Product search demo. 
 
See https://wordpress.org/plugins/post-tags-and-categories-for-pages/ 

 

WP Dark Mode 
This free plugin allows switching between dark mode and normal. Site Search ONE Version 1.5 has 
preliminary support of this plugin in the search results and hit viewer. Support for other dark mode switchers 
may be added later, feedback welcome. 
See: https://wordpress.org/plugins/wp-dark-mode/ 
 

https://wordpress.org/support/article/custom-fields/
https://en-gb.wordpress.org/plugins/advanced-custom-fields/
https://wordpress.org/plugins/post-tags-and-categories-for-pages/
https://wordpress.org/plugins/wp-dark-mode/
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Category Posts Plugin 
 
The standard WordPress Recent Posts Widget does not have a facility for choosing to display only posts from 
a certain Category.  
 
If you are using the Recent Posts widget in your Blog or News Page and some other page, and only want to 
include posts from one Category you will need to install a plugin that will enable you to just display Recent 
Posts from a selected Category. 

 
On https://dtsearch.co.uk to prevent our demonstration Legal Posts from appearing in the Recent Posts 
Widget (Recent News) the site uses the Category Posts Plugin. 

After installing the plugin, from the WordPress Dashboard go to Appearance > Customize and select your 
Blog or News page. In the Sidebar widget area choose +Add a Widget and select Category Posts.  

In Category Posts: Change the Title as needed, under Filter select just the Category you need, the number 
of posts to show, and other options as needed, then Publish. 

 

 

https://dtsearch.co.uk/
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Adding, using existing or deleting search boxes 
 
If your WordPress site is using the default WordPress search widget or a search bar hard coded in your 
theme, you may want to remove them or redirect search queries from them to your Site Search ONE search 
page. 

 
Be aware that just removing the search box will not prevent someone from sending a search query via the 
URL, this may mean they can search post or pages that you do not want to be exposed. 

Removing search boxes 
A safe way to remove not only the search box but to disable search is to use a plugin: 
https://wordpress.org/plugins/disable-search/  prevents WordPress from allowing and handling any search 
requests from the front-end of the site. 
 

Features of the Disable Search plugin include: 

• Prevents the search form from appearing if the theme uses the standard get_search_form() function 
or if the theme uses a searchform.php template. 
 

• Disables the search widget, removes it from the list of available widgets, and deactivates any search 
widgets currently in use in any sidebars; they are hidden, not deleted; they will reappear in their 
original locations if the plugin gets deactivated. 
 

• Prevents the search item from appearing in the admin tool bar when shown on the front-end. 
 

• With or without a search form, the plugin prevents any direct or manual requests by visitors, via GET 
or POST requests, from returning any search results; submitted attempts at a search will be given a 
404 File Not Found response, rendered by your site’s 404.php template, if present. 
 

• Disables output of SearchAction in SEO schema by the YOAST SEO plugin. 

The plugin only affects search on the front-end of the site. It does not disable searching in the admin section 
of the site. 

  

https://wordpress.org/plugins/disable-search/
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Use Existing Search Box 
 
You can use an existing search box to send search queries to a Search Site ONE search page.  

From WordPress Dashboard Site Search One > All Search Pages scroll to the name of the search page you 
want to search, check the checkbox in the Default column alongside the name of the search page: 

 

 
In the example above, a search entered in the default search box will be passed to the Book Search page. 
Although the search box will not have a Filter button, if the chosen search page has fields (Filters) a user can 
still narrow the results by typing a field search, for example:  

Example of a theme supplied search box edited to include a 
Unicode 1F50D search icon. 
 

If you want to use an existing search box to send search queries to all the indexes in a Categorized search 
page, you can create a ‘search all’ default item for that purpose. See page 17. 
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Edit theme search box 
 

 

dtSearch Corp. is a Unicode Consortium Official Gold Sponsor 
of Unicode search symbols 1F50D and IF50E 

 

To add an icon to a theme search box like the demo on the dtSearch UK website, from the WordPress 
Dashboard Appearances > Theme Editor find the child theme and edit the search button code as shown 
below, your site font may need changing to achieve this: 
 
<button type="submit" class="Search_btn" title="Powered by SiteSearchONE" 
name="submit" >&#x1F50D;</button> 

 
Note:  the code above from the demo on the dtSearch UK website also includes title="Powered by 
SiteSearchONE" to display Powered by SiteSearchOne if the mouse is hovered over the search button. 
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Adding a search box 
 

Site Search One has a shortcode that allows a search box to be placed anywhere that allows a shortcode; it is 
in the format [ss1-search-bar page=ID]. 
 

• In WordPress Dashboard select the search page you wish to search, and press Edit.  
Look in the address bar of the browser and make a note of the post ID, for example you may see 
https://example.com/wp-admin/post.php?post=2533&action=edit (2533 is the post ID) 

• Use that ID in the shortcode i.e. [ss1-search-bar page=2533] and type that anywhere that allows a 
shortcode, for example in the body or title of a page: 

 
 

 

 
 

 
Note the search box will inherit theme styles, it can be customized further, or those styles overridden by 
styling the class ss1-searchbar. 

 

 

 

 

A more comprehensive Search Bar Widget is now included in the basic plugin, this has all the features of the 
search bar on the search results page, it can be placed in any Widget section of your site.  
  

https://example.com/wp-admin/post.php?post=2533&action=edit
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Search Help 
 

If your site is using just an All Words search, your site visitors may be able to quickly find what they want by 
entering one or two words. Perhaps a simple ‘search tips’ note on your page might suggest adding more 
words to narrow a search or remove words if no results are found. An Any word search is even simpler and 
will lessen the chance of the site visitor getting ‘no results’, however for a large site it is not recommended; 
for searching a small number of pages or posts the results are so broad the results will be comparable with 
the standard WordPress search.  

 
Site Search ONE Basic Professional Search is intended for more professional users that need to search tens of 
thousands of posts or pages. To be able to focus search results down to a certain matter in a particular court 
case for example will almost certainly require the use of Boolean search techniques.  

While the basic AND, OR logic is understood by many, the way that proximity or phonic (Soundex) or 
“wildcard” operators are used varies between search engines. Therefore, it is best to offer your site visitors a 
Help page that explains the search query options in detail, with some examples that are relevant to the topics 
on your website. 

 

An example search page is provided here: Search Help – dtSearch UK ; this is similar to the search help 
provided at Search Help - Search Cloud One but also provides information on All Words and Any Word 
search in addition to Boolean search. Both pages are based on the information provided at dtSearch Web 
Search Help . 

You can adapt the information on the pages above for your own search help page, the smooth scrolling 
effect is achieved by using the Page scroll to id WordPress Plugin. 

 

Page Scroll to ID plugin 
 

The plugin’s help shows how to create anchor links and target tags using the Gutenberg (Block) editor if you 
are not familiar with the technique.  
 
If you have a fixed positioned/sticky menu which overlaps your target’s content when page scrolling is 
completed, if you use the Page Scroll to id plugin you can insert your menu CSS selector or a fixed pixel value 
in the Offset Field. For example, inserting #navigation-menu will offset the scroll-to position according to 
the height/width/position of the element with the id navigation-menu, if you are unsure how to do this you 
can simply try setting the Offset value to100 to offset the page scrolling by 100 pixels, then adjust the value 
until the correct anchor text is visible at the top of the page. 

 

  

https://dtsearch.co.uk/search-help/
https://searchcloudone.com/search-help/
http://support.dtsearch.com/support/forms/iframes_advanced/default_help.html
http://support.dtsearch.com/support/forms/iframes_advanced/default_help.html
https://wordpress.org/plugins/page-scroll-to-id/
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Translation 
 
The default language of the plugin user interface is English. Site Search ONE is supplied with pseudo localized 
compiled translation test files site-search-one_psuedo.mo and site-search-one-fr_FR.mo; change the site 
language under Settings > General > Site Language to French and click Save Changes. You will see all the 
English text is replaced by pseudo-language with a width 30% wider than English to take into account the 
typical expansion that occurs in translating from English to many other languages. 

 
To translate the user interface, download the site-search-one.zip file and extract all the files. Make a copy of 
the template file site-search-one.pot which is in the \languages folder.  

Install and open the free Poedit - see https://poedit.net/wordpress 
 
Select Create new... 

 
 
 
For each line of text add a translation in the 
Translation field at the bottom of the window. 
 
Save the file as site-search-one-{locale}.mo 
where {locale} is in the format language 
COUNTRY CODE,  
e.g., site-search-one-fr_CA.mo, for Canadian 
French. 
 
Poedit Pro can directly connect via FTP, otherwise 
use a program such as FileZilla to copy the 
compiled translation file to the languages folder 
in the plugin directory: 
e.g.  /wp-content/plugins/site-search-
one/languages/site-search-one-fr_CA.mo 
  
To test the translation, set the site language to 
the language of the translation file under 
Settings > General > Site Language and click 
Save Changes. 
 
 

 
For multilingual sites see: https://wpml.org/documentation/support/translating-the-theme-you-created/> 
  

https://poedit.net/wordpress
https://wpml.org/documentation/support/translating-the-theme-you-created/
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Custom CSS 
 
Although our aim is to produce the best ‘no-code’ solution for professional search on WordPress, we 
understand that web agencies or site administrators might like to customize beyond what we currently offer 
with ‘no-code’.  
 
(New in version 1.9)  Custom CSS and the Link Format for search results can have Global Settings.. 
 
If you need assistance, please contact support@dtsearch.co.uk we will be pleased to help at no charge if you 
have a current subscription or are in the 30-day evaluation period.  
 
From the WordPress admin area select Site Search ONE > All Search Pages click on the Options button of 
the search page you need to edit. 

 

 
 
 
 
 
 
 
 
 
 
Search Page CSS 
For example, use this section if you 
need to adjust the width of the 
Facets (Categories | Posts) section in 
the search results page. 
 
 
 
 
 
Document CSS 
If you are displaying the selected 
search result in the hit-viewer, you can 
use this section to change the colour 
of the hit-highlights, or choose a 
different text font, for example. 
 
 
 
 

 
Some Custom CSS code examples are on the following pages. We may add ‘no-code’ solutions for 
some of the examples in later versions of the plug-in. All suggestions welcome! 
  

mailto:support@dtsearch.co.uk
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Custom CSS Examples 
If you have long names for Categories, Tags or Custom Field names you may want extra width for the facets, 
see example at bottom with facets for Brands etc. 

 Wider facets 

#search-outcome-container.frc-limited .facet-field { 
   min-width: 250px; 
} 
#search-outcome-container.frc-limited .facet-value-dsp { 
   max-width: 200px; 
} 
.field-values .checkbox {  
   max-width: 250px; 
} 

 
 

 
If you have a non-white background, you may need to add some padding so that controls are inset. 
Below are examples for changing font, dark mode, etc. 
 
body { 
   padding: 0.5em; 
   background-color: black; 
   colour: lightgray; 
   font-family: "Times New Roman", Georgia, serif; 
   font-size: 2em; 
} 
 
a { 
   color: rgb(69, 155, 230); 
} 
.dark-mode body{ 
   background-color: #1b2836;  
   color: #fff; 
} 
.dark-mode #filter-panel{ 
   background-color: #1b2836; 
} 
.dark-mode .datepicker { 
   color: #000; 
} 
.dark-mode .modal-content { 
   color: #000; 
} 
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Custom CSS Examples – Document 
 
Site Search ONE supports multiple hit highlight colours.  

 
 
 
Hit viewer hit highlight:  use color_1 to color_5 
 
 
There are 140 color names supported by modern browsers, in 
addition you can use hex values if you prefer or need to match 
existing color schemes. 
 
For examples of text color to use with background-color  
see: https://www.w3schools.com/cssref/css_colors.asp 
 
For details of box-shadow see: 
https://www.w3schools.com/CSSref/css3_pr_box-shadow.asp 
 
 
 
With these example settings a Boolean search of:  
grey and mercedes and sedan and V6 and diesel 
 
or an All words or Any Words search of: 
grey mercedes sedan V6 diesel  
 
will produce the result below:  
 
You can also make the font the same as in the results 
body { 
   font-family: "Times New Roman", Georgia, serif; 
} 

 

 
 
  

.active_hit { 
    color: black !important; 
    background-color: white 
!important; 
    font-size: 120% 
!important; 
    border: 2px solid red; 
    border-radius: 15px; 
    box-shadow: 2px 2px grey; 
    padding:  0em 1em; 
} 
.color_1 { 
  background-color: pink; 
} 
 
.color_2 { 
   background-color: yellow; 
} 
 
.color_3 { 
   color: white;  
   background-color: aqua; 
 
} 
 
.color_4 { 
   color: white;  
   background-color: maroon; 
} 
 
.color_5 { 
   color: white;  
   background-color: green; 
} 

https://www.w3schools.com/cssref/css_colors.asp
https://www.w3schools.com/CSSref/css3_pr_box-shadow.asp
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Global Settings 
 

You can enter Custom CSS or Link Format settings that will apply globally to all search pages. 
 

 

 

Custom CSS 
Search Page CSS, Widget CSS, or Document CSS. 
 
The Global Settings CSS is combined with the CSS on the search page, i.e., it is applied as two separate 
stylesheets, the same way that you can normally add multiple CSS stylesheets to a document.  
 
It is possible to have global styles and additional styles specific to a search page.  
 
It is also possible to unset specific rules using the 'unset' CSS keyword, override them using a more specific 
selector, or by using the !important property. 
 
 
Link Format 
The global setting will be used if the following conditions are true: 
 
1. The global setting is not blank 
 
2. The search page link format setting is either blank, or unchanged from the default link format 
Therefor it's possible for a search page to override the global setting by using a non-default link format 
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Adding Custom Scripts and Stylesheets to SERP, Hit viewer, PDF 
Viewer and Search Widget 
 

(Applies to version 2.0 and later) 

The plug-in now uses templates to control the appearance or behaviour of the Search Engine Results Page 
(SERP), Hit viewer, PDF Viewer and Search Widget.  
  
The templates should not be edited directly since they will get overwritten whenever the plugin is updated. 
To customize the templates, you should add scripts and styles using the wp_enqueue functions in 
functions.php in a child theme. 

 
Editing functions.php 
 

The functions.php file is included in every WordPress theme. To ensure that changes made to functions.php 
are not lost with theme updates, create a child theme: 

1. Access the websites file system and navigate to wp-content > themes 
2. Make a copy of the website’s active theme and append the folder name with -child. For example, if 

your theme is twentytwenty make a copy named twentytwenty-child 

Normally you will need access to the website file system to create a child them or edit the functions.php file; 
this can be achieved using FTP or an online control panel depending on the hosting provider. However, there 
are plugins and other methods to achieve this, if you are not sure please contact support@dtsearch.co.uk for 
assistance. 
 

Handles 
 

In WordPress, enqueued scripts and styles use handles to identify each enqueued item. Site Search ONE will 
only add scripts and styles to the page if the handle is correctly prepended for the type of page. 

Depending on where a script or style should appear, its handle should be prepended as follows: 
 

Prepend with To be placed on 

site-search-one-serp_ Search Engine Results Page (SERP) 

site-search-one-widget_ Search Widgets 

site_search_one_hitviewer_ Hitviewer 

site_search_one_pdfviewer_ The PDF Viewer 

 

For example, if my-script.js is enqueued with the handle ‘site-search-one-serp_my-script’ it will be added to 
the Search Engine Results Page. 

 
 

mailto:support@dtsearch.co.uk
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Adding custom JavaScript 
 

1. Inside the child theme folder, create or upload a new javascript file such as my-script.js containing 
your custom javascript. 

2. Inside the child theme folder, find and edit functions.php. Add the following code to the page: 

 

 

 

 

 

 

3. Replace site-search-one-serp_my-script with a handle appropriate for the type of page, see handles on 
previous page). 

4. If you named the javascript file something other than ‘my-script.js’ remember to change the handle 
and file location in the wp_enqueue_script function. 
 

Adding custom CSS Stylesheets 
 

Counter-intuitively, you should also use the same wp_enqueue_scripts action to enqueue styles. 

 
1. Inside the child theme folder, create or upload a new CSS Stylesheet file such as my-style.css 

containing any custom styles desired on the page. 
 

2. Inside the child the folder, find and edit functions.php. Add the wp_enqueue_style function to the 
same register_my_custom_scripts function 
 

 

3. Replace site-search-one-serp_my-style with a handle appropriate for the type of page you wish the 
script to be added to (Refer to handles on the previous page). 
 

4. If you named your CSS file something other than ‘my-style.css’ remember to change the handle and 
file location in the wp_enqueue_style function.  

function register_my_custom_scripts() { 

 wp_enqueue_script('site-search-one-serp_my-script', 
get_template_directory_uri() . '/my-script.js'); 

} 

 

add_action('wp_enqueue_scripts','register_my_custom_scripts'); 

function register_my_custom_scripts() { 

 wp_enqueue_script('site-search-one-serp_my-script', 
get_template_directory_uri() . '/my-script.js'); 

 wp_enqueue_style('site-search-one-serp_my-style', 
get_template_directory_uri() . '/my-style.css'); 

} 

 

add_action('wp_enqueue_scripts','register_my_custom_scripts'); 
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Get Help 
If you need assistance with setting up Site Search ONE, please contact support@dtsearch.co.uk or use the 
Contact Us form on the About menu or in the footer section of the dtSearch UK website. 

Feedback 
Please give us feedback on this user guide so that we can provide content that is useful and helpful. 

Thank you! 

 

 

 

All suggestions for improvement of the product and this manual are very welcome! 

 

 

  

mailto:support@dtsearch.co.uk
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dtSearch Indexes 
The dtSearch Engine for Linux is 64-bit with a recommended maximum index capacity of 1Tb of data 
(Theoretically the limit is 4Tb). While you could include all your site content in a single index, we recommend 
that you split the search content up over several indexes. The maximum theoretical number of documents in 
an index is 2 billion. 

Pause synchronising 
Indexes are updated automatically soon after you Publish or Update any Post or Page.  
If you import many posts, you may want to edit Categories, Tags or Published date before they are 
added to an index. Version 1.7 onwards allows you to Pause synchronising so that you can 
accomplish this. 

 
 
Obsolete data and fragmentation  

Obsolete data comes from posts that are reindexed and from posts that are removed from the 
index. In both cases, the data is not removed from the index but is tagged as "obsolete" for removal 
the next time the index is compressed. 

Fragmentation occurs when an index is updated. Each time an index update commits, 
fragmentation of the index increases. For example, if you build an index and then update it 5 times, 
fragmentation would be at least 6.  

On each update, data is appended to the index, without affecting fragmentation of the existing data. 
For example, if you start with a 1 Gb index that is fully compressed and update it 10 times, each time 
adding one post, fragmentation will be 11 but only a tiny percentage of the index data will be 
fragmented. 

Each time the index is updated it becomes more fragmented which will over time slow search results; typically 
Posts on your website might be updated frequently, whereas Pages may seldom be edited, by keeping Pages 
separate and by splitting up Posts and Custom Posts your site visitors will be searching on just the area of 
content they are interested in. 

 
On All Index Pages the buttons below allow manual updates: 

Rebuild 
Rebuilding an index will interrupt searching; by splitting up your search by using categorized search, if 
rebuilding an index is necessary, it will only affect searching of a smaller section of your site. Normally when 
you create a new search page the index will be created and updated automatically. However, there may be 
times that the content or index structure changes due to new search engine updates, changes to the search 
API or new fields created that manual maintenance is needed. 
 

Update 
Updating an index does not interrupt searching and can be carried out manually at any time.  

 



54 

Compress 
Compressing an index only needs to be done if the fragmentation is high (>50), it will improve the search 
response time if it is slow. 
Details here:  https://support.dtsearch.com/webhelp/dtSearchCppApi/Compressing_Index.html 

https://support.dtsearch.com/webhelp/dtSearchCppApi/Compressing_Index.html
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Release Notes 
Initial public beta release was 23 April 2021 
Latest beta Release notes can be found here: Release Notes - Site Search ONE - beta - dtSearch UK 

 

Limits 
 
Built in limits as of 26 Jan 2022: 

• Title Field: 80 characters max. 
• Stemming: English only (Contact support@dtsearch.co.uk if you need this changed for another 

language, see the available languages here:  https://dtsearch.co.uk/language-list/ No extra charge. 
Contact us if your site needs multiple stemming language choices. 

• Synonyms: English WordNet Thesaurus. (If your searchable posts/pages are not in English, please 
contact us for alternative solutions). 

• Facets: The facet checkboxes are sorted by count and will display up to 5 checkboxes per facet (3 in 
mobile view, above the search results), with a more… link that can display up to 64 values. There is a 
limit of 2048 on the sort count; keep the total number of tags, categories or custom taxonomies 
below this limit. If you require more, please contact us). 

• Indexes: the dtSearch Engine can handle 1Tb of text per index, however if your site has a mix of old 
archive material and recent posts that may be edited, keep them in separate indexes, so that 
rebuilding or incremental index updates can be performed quickly.  

• Search Query: 256 characters max length 
• Search Query Type: Boolean is default; All Words, Any Words are optional per search page. 
• Noise words:  none (Contact us if you need a noise/stop word list on your site) 
• Search Results: Paginated 10 per page, 50 pages 
• Multicolor hit-highlighting is supported in the post/page itself contact us if you need specific colors 

for your website.  
• Words in context: the search results include a snippet of text surrounding the ‘hit word(s)’, the 

default is 25 words either side of the search hit; this can be adjusted from Options | Link format  
• Translation: The plugin is translation ready, if you have a multi-lingual site and need WPML 

compatibility please contact support@dtsearch.co.uk 
• General: Site Search ONE Basic Professional Site search plugin is designed for informational sites that 

have up to about 40,000 posts and pages for reasonable performance. It is intended for sites that 
have a modest amount of search traffic and currently we do not limit the number or frequency of 
search requests or the size or number of indexes; we will keep this under review and reserve the right 
to limit these in future, this will not be done without prior notice. The search as a service is not 
intended for very high traffic commercial sites (e.g., Amazon). Please ask if you believe your site may 
generate extreme loads on our servers. 

  

https://dtsearch.co.uk/products/release-notes-site-search-one-beta/
mailto:support@dtsearch.co.uk
https://dtsearch.co.uk/language-list/
mailto:support@dtsearch.co.uk
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Premium add-ons 
 

The standard product can have additional features added later, these are detailed in the User Guide for Site 
Search ONE WordPress Plugin Premium Add-ons  

 
 

Known Issues 
 
30.4.3 Hit Viewer will not display images created by SiteOrigin Page builder 

 

In the pipeline…. 
We are adding new features as quick as we can from our roadmap to the standard version, if you have a need 
that’s on your current search solution, contact us, it may be in the pipeline! Better still, let us know if you have 
a need that isn’t on your current search solution! 

 

Endpoints 
Use of the Site Search ONE plugin requires connection to an endpoint on AWS that provides the dtSearch 
Engine REST API, an SQL database that stores your license key, and other data. Currently the endpoint is 
fixed, but if you need to connect to another endpoint the procedure is below. 
  
Download site-search-one.zip, right click on the file and choose Extract All... 
 
In the extracted site-search-one folder, locate site-search-one.php and open it in NotePad or other text 
editor program. 
  
Locate the lines with ss1-endpoint-url, edit as needed and save. 
 
 * Whether or not the plugin uses the Test Server. 
 */ 
define('SITE_SEARCH_ONE_USE_TEST_SERVER', false); 
  
if (SITE_SEARCH_ONE_USE_TEST_SERVER) { 
    set_transient('ss1-endpoint-url','https://testapi.searchcloudone.com'); 
} else { 
    set_transient('ss1-endpoint-url', 'https://api.searchcloudone.com'); 
} 
 
Right click on the site-search-one folder, choose Send to > Compressed (zipped) folder. 
  
Install the modified site-search-one.zip file into WordPress as usual. 
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